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Inbox 

When Outlook 2003 appears, you will be in the Inbox where the mail you receive is 
located.  Your Inbox screen should look something like this: 

 

The mail messages that you receive will be listed in chronological order.   

 

Left Mouse Button  

In this tutorial, whenever we indicate that you need to click a mouse button, it will mean to 
click the left mouse button – unless we specifically indicate that you should click the right 
mouse button.  So, always move the cursor over the “place” we indicate and “click left” unless 
we tell you otherwise. 
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Different Views in Outlook 2003 

Navigation Pane 

When you first open Outlook 2003, your screen 
will normally look like the image above.  On the 
left side of the screen is called the Navigation 
Pane (see the image on the right).  The top area 
indicates Mail .  Below Mail  there are two areas:  
Favorite Folders and All Mail Folders .   

Below the Mail  area you’ll see a series of buttons:  
Mail , Calendar, Contacts, Folder List and 
Shortcuts.  Notice that the Mail button is orange.  
This means that this button has been selected 
(when you opened Outlook Mail ).   

If you click the left mouse button on Calendar, the 
Calendar will appear on the right side of the screen 
and the Calendar button will turn orange.  The 
same thing will happen when you click on 
Contacts, Folder List and Shortcuts. Give this a 
try.  When you are finished, click on Mail  once 
again. 

To change the navigation pane so that it looks like 
you want it to, you look for the symbols >> at the 
lower right corner of the navigation pane.  When 
you move your mouse over the symbols >>, your 
cursor will change to a little pointy hand, and a 
configure buttons choice will appear.  Then, click 
on the >>. 
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When you click, the drop down menu to the right will 
appear.  You’ll notice the choices:  Show Fewer 
Buttons, Navigation Pane Options, and Add or 
Remove Buttons. 

First, if you don’t want as many buttons to appear, click 
on Show Fewer Buttons.  You’ll have to click on the 
>> each time you want to get this menu again.  To bring 
the buttons back to the navigation pane, click on Show 
More Buttons.  Give this a try and set your navigation pane as you want. 

Click on Navigation Pane Options… and the below Navigation Pane Options menu 
screen will appear. 

 
There are a number of choices with this screen.  

First, notice that there are little 
green “check marks” in some 
of the boxes.  These are the 
buttons that currently appear in 
the navigation pane.  If you 
don’t want a box to appear, 
click the check mark and it will 
disappear – and the box won’t 
show.   

If you want to change the order 
of the buttons, notice the Move Down and Move Up choices on the right side of this 
menu screen.  If you click on one of the main buttons (like Mail  above –which is blue), 
and click the Move Down button, you will see Mail  move down your button list.  
Navigation Pane Options allows you to set your buttons just like you want. 
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Click on the Add or Remove Buttons 
choice and you will see a pop-up 
menu appear to the right of the choice.  
You can click on a button (like Mail ) 
and it will disappear, or appear when 
you click again.  This is called 
“ toggling.”  Each time you click, the 
button appears or disappears. 

You have a lot of choices on how to 
show/add, hide/remove buttons from 
your navigation pane.  You choose the method you like best from the ones we have just 
shown you. 

Mail Views 

There are several different ways to set-up a “view” that you like best.  The layout you see 
when starting Outlook for the first time is the default view.  We’ll show you how to set 
several different views and you can choose the one you like best.   

To view the Reading Pane selections, click on View in the menu bar and then click 
Reading Pane.  You will see three suggestions to the right of Reading Pane—Right, 
Bottom, and Off .  
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Click on Right.  Microsoft added this view to Outlook 2003 as another way to read your 
messages.  You will see the text of a message displayed on the right side of your screen 
like the image below. 

 

 

 

 

 

 

 

 

 

 

 

Text on Right 

Message on Left 
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Now we’ll repeat what we did on the 
last page, but place the reading page 
on the Bottom. 

 

 

 

 

Text on Bottom 

Message on Top 
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Now for the last choice.  Repeat what you 
did on the last two pages, but choose Off . 

 

 

 

 

 

 

 

 

 

 

 

 

 

You choose the Reading Pane that you like the best. 

Next, we’ll work with the Auto Preview.  To do this 
you’ll need to click on View in the menu bar.  When 
the drop down menu appears, you’ll see a selection 
called Auto Preview.  This is called a “toggle” button 
as it can either be “on” or “off.”  Click on the Auto 
Preview button. When you do, Auto Preview will 
appear or disappear from your screen.   

All of your messages on one 
screen – NO Reading Pane 
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The below image has Auto Preview on the left and Reading Pane on the right.  You can 
see a few lines of the message in Auto Preview, below the incoming message data. 

 

The below image has Auto Preview on the top and Reading Pane below the message.  
You can see a few lines of the message in Auto Preview, below the incoming message 
data. 

 

The below image has Auto Preview ONLY—no Reading pane.  You can see a few lines 
of the message in Auto Preview, below the incoming message data. 
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Folders & Messages  

 

When you first opened Outlook 2003, the area to the left of the 
screen looked something like the image to the left.  The icons you 
see take you to different features of Outlook (Calendar, etc.) or 
contain email.   

The icons we are concerned with in this tutorial are the ones that 
pertain to email and hold messages (e.g. Inbox, Sent Items, 
Deleted Items). 

When Information Services staff set-up your Outlook 2003 account, 
they create limits for the amount of mail messages you can have in 
your mailbox (1 GB).  When you get near this limit, you will 
receive a cautionary message, indicating that you need to delete 
messages that are no longer needed.   

Creating Folders 

To create Folders for storing your email, do the following: 

Click on File in the menu 
bar, then click on New in the 
drop down menu, and then 
click on Folder… 

 

 

Note for Outlook 98/2000 users who upgraded to Outl ook 2003   

You probably noticed that the Outlook Bar, on the left of the screen, had been replaced by a 
whole new folder and icon area (navigation pane).  No longer are there Outlook Shortcuts , 
My Shortcuts  and Other Shortcuts  areas.  The prior Outlook Today  icon has been replaced 
by a mailbox with your name on it.  We’ll review the new navigation pane, which we introduced 
at the beginning of the tutorial, which replaces the Outlook bar. 
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The Create New Folder screen will appear. 

First, select a logical name for the folder.  
For this tutorial we’ll use the title “My 
Junk.”  Type the name you want in the 
Name area.   

Select the location you want the new folder 
to be placed.  Some people like all their 
folders to actually be subfolders in the 
Inbox folder, while others prefer the folders 
to be at the same level (under “Mailbox”). 

Now, click on OK. 

As you receive or send email related to your 
folder topic, you can move the email to that 
folder so that you can find the items easily, 
without having to search all of your mail.  You can still delete these items when they no 
longer apply and delete the folder when you are finished with it.   

Moving Messages 

You will notice, in the preview pane All 
Mail Folders area, that when you click on 
Inbox, Sent Items, or Deleted Items, that 
the folders you created can still be seen in 
the preview pane on the left side of the 
screen.   

To “move” an email from one folder 
(Inbox, etc.) to another folder, you simply 
click and hold on the email message you 
want to move, and drag the message to the 
wanted folder.   

You will notice, as you are “dragging” your email message, a small box appears 
“attached” to the cursor arrow. The cursor changes to a circle with a line through it (when 
you are over an area where you can’t drop your message), and then changes again to the 
box with the arrow when you have the cursor over a folder icon.  When you have the box 
symbol over your folder, release the left mouse button.  This will move the message 
from one folder to another.   
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You can also move several 
messages with this drag 
technique. 

To highlight several 
messages, hold down one of 
the Ctrl  keys and then click 
on several messages, you’ll 
notice that as you click each 
message it is highlighted 
(see the image on the left).   

When you are ready to move 
the group of messages you 
highlighted, simply click and 
hold on any of the 
highlighted messages, and 
while holding down the left 
mouse button, drag all the 
messages to the folder where 

you want the messages, then release the mouse button.  If you ever want to turn off the 
multiple highlights, you simply click on any message and that will remove the highlights 
and select the message on which you clicked. 

You can also click on a message and, either using Edit  (in the menu bar), then Copy or 
Cut in the menu bar, and then Paste, to move or copy a message in this manner.  You can 
also use the Cut, Copy and Paste buttons in the button bar. 

Deleting Messages 

To delete a message, you have already learned that you can click on the message and 
then on the “X” in the tool bar on the top 
of the screen.   

When you delete an email message in 
your Inbox, Sent Items, or a folder, this 
places the message in the Deleted Items 
“trash can.”  You can “drag” or cut and 
paste items from Deleted Items to any folder to retrieve it. 

To permanently delete an email message in the Deleted Items trash can, you can click on 
the message and click on the “X” button, or tap the Delete key.  Outlook 2003 will ask 
you if you “really” want to delete the message.  When you say yes, it’s gone forever.  To 
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delete several individual messages at once, click on the first message, then hold down the 
Ctrl  key while clicking on the other messages.  Now click the “X” button or tap the 
Delete key.  If you want to delete ALL of the items in the Delete Items trash can, click 
on Edit  in the menu bar and then Select All, or use Ctrl-A .  Then, click on the “X” 
button or tap the Delete key. A message box will appear asking if you really want to 
delete all the items.  If you do, click on Yes.  

Reviewing Messages in the Inbox 

To view a message, simply double-click quickly on the message and the following screen 
will appear.  

 

You could also click once on a 
message and then click on File (in 
the menu bar), then click on Open, 
then click on Selected Items. 

You will now see a screen similar to the one below.  This screen is designed to review 
and respond to mail messages received.   

 

Replying to a Message 

Look at the button bar at the top of the 
screen (see the image on the left).  
Notice that you can click on Reply, and, 
automatically reply to the person who 
sent the message, or Reply to All.  When 

you click on Reply or Reply to All, you will notice that Outlook 2003 “automatically” 
completes the To: and/or Cc: in your outgoing message.   
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You then click in the “white” message area below the To, Cc, and Subject, and 
supplement the original message with any additional comments you want to make 
regarding the message to which you are replying. 

 

After you have made any comments, you can click on the small Send box below File in 
the menu bar and your reply will be “mailed.” 

Forwarding a Message 

If you want to forward a message to someone or others, click on the Forward button 
(next to the Reply and Reply to All buttons), then click in the To or Cc areas.  You may 
type in the email address or addresses of those to whom you want to forward the mail 
message.  If you have more than one address, separate them with a semi-colon (;).   

Envelopes 

When a message first arrives in your Inbox, and has not been read, you’ll 
notice that the envelope is closed. Once you have read the message, but not 
replied, the envelope will appear opened. When you reply to or forward a 
message in Outlook 2003, it will now have a small arrow attached to a 
small box by the message.  These arrows indicate that the message has been 
forwarded or replied to.  A purple arrow pointing to the left indicate you 
have replied to a message; a blue arrow pointing to the right indicates that 
you forwarded that message.  The arrows will be the same as on the Reply, 
Reply to All, and Forward buttons. 

Moving From Message to Message in the Inbox 

Notice the large blue Up and Down Arrows in the button bar below 
the menu bar.  They are only visible when you are “in a message.”  
These allow you to move forward and backward (Previous Item and 
Next Item) between messages in the Inbox.   
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Printing a Message 

If you want a “printed copy” of the message you can click on the Printer  in the button 
bar.  Or, you can click on File in the menu bar and then on Print . 

 

 

Creating and Sending a Message 

If you are in the Inbox and want to send a new email message to a person or group of 
persons, click on the New mail message button in the button part of the tool bar. 

If you are in some other part of 
Outlook 2003 and do not see the 
New mail message button, you can 
always (in the Inbox as well) click 
on File in the menu bar, then click 
on New, and then click on Mail 
Message.   

In both cases, the below screen should appear. 

 

First, click in the area to the right of To.  For now, type in the email address of the 
person, or persons, to whom you want to send this email message (see the subheading 
below, Addressing Email, for more tips).  Next, click in the area to the right of Cc.  
Again, type in the name or names of others whom you would like to receive copies of this 
message.  If you type in more than one email address, separate the addresses with a semi-
colon (;).  You may also use the Address Book, which is discussed later.     



Outlook  
User Guide 
 

 
Adapted with permission from materials from Lynchburg College, Last Updated 1/7/2008 15 of 50 

Now click in the area to the right of Subject, and type in a subject for your email 
message if you want.  You do not need a Subject description if you do not want one. 

Finally, click in the white area below Subject, and type in a title for your email message.  
You may move around, edit, and change your.   

When you have completed your email message, click on the Send 
button in the upper left hand corner of the screen.   

Addressing Email 

Outlook connects to the School of Nursing account directory, as well as the University of 
Washington directory.  This means you can just start typing in any SON or UW name in 
the “To” field and it will try to figure out who you intend.  If Outlook doesn’t recognize 
the name right away, you can click the Check Names button to double check. 

 

If Outlook comes up with several options for who you might want, a pop up window will 
appear and you can either click on the right name or use your down arrow key to select 
the right one, and then press enter.   

If Outlook cannot resolve the name of the person with what you have typed, it will leave 
your entry as is and add a red underline to it.  You can right-click on the red underlined 
name to look for more possible matches or create a new Contact entry. 

If Outlook correctly determines the person you intend, the name will be underlined in 
black.  You can then right-click on the black underlined name for more options 
(including calendar availability), or double-click on it to bring up directory information 
for this person (including phone numbers). 

Using Microsoft Word as Your Email Editor 

You may use Microsoft Word as your email editor, if you have it installed on your 
computer.  To activate Word, make sure that you 
are in the Inbox, Sent Items or Deleted Items 
screen. Click on Tools in the menu bar, and then 
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click on Options in 
the drop down 
menu that appears. 

When the Options 
menu screen 
appears, click on 
the Mail Format  
tab.  If you want to 
use Word as your 
editor (with all of 
the full word 
processing 
features), click in 
the boxes to the left 
of Use Microsoft 
Word 2003 to edit 
email messages 
and Use Microsoft 
Word 2003 to read 
Rich Text email 
messages.   

Then click on the 
Apply  button and 
then click on the 
OK button.   

The next time you create a new email, or reply or forward an email, you will see a little 
message appear that indicates that Word is being loaded as your editor.  At the top of the 
screen you’ll see additional, new toolbars for using Word.  When you are typing your 
email messages you will have all of the power that is inherent in Microsoft Word 2003. 
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Address Books 

When you have clicked on Reply, 
Reply to All, or Forward or created a 
new email message, you will see a 
screen similar to this one. 

If you are Replying or Replying to 
All  on an email message in your 
Inbox, then the addresses from that 
email will automatically appear in the 
To and Cc areas.  If you don’t want to 
send the email to some of these 
addresses, you can simply click on them and tap the Delete key.  If you are Forwarding a 
message from the Inbox or sending a new email message, then you can either type in the 
address in the To or Cc area, or use the Global Address List or Contacts address book. 

Global Address List 

To access these address books/lists click 
on the To or Cc or Bcc buttons (see 
arrows on the picture above).  The Global 
Address List menu box will appear. 

When you are in the Reply, Reply to All,  
Forward or create a New email message 
screen, and need to add additional email 
addresses, you can type in the addresses—
or use the Global Address List. 

When you have clicked on either the To or 
Cc buttons this screen will appear. Click 
the drop down where it says “UW 
Directory ,” then select the “Global 
Address List.” 



Outlook  
User Guide 
 

 
Adapted with permission from materials from Lynchburg College, Last Updated 1/7/2008 18 of 50 

The Global Address List contains all of 
the people in the School of Nursing.  You 
can search or browse through the list.  
This list is created and updated by 
Information Services staff.  Entries on the 
Global Address List are restricted to 
people with School of Nursing accounts – 
faculty, staff, instructors, graduate 
teaching or research assistants, and official 
affiliates. 

To use this list, simply click on the person 
(or distribution list ) whom you want to 
receive the email, or you can type their 
name in the area below “Type name or 
Select from list.”  The list of names, below 
where you typed the name, moves to all of 
the persons with that name (the list is in 
first name order).  Then, click on the To, 
Cc or Bcc buttons.  This will add the address to those already in the email (you will see it 
appear in the area to the right). You can do this for as many addresses as you want.  
When you have finished, click on OK, and you return to your message.   

Contacts 

How can you create your own “automatic” address list for someone who is not on the 
campus/business Outlook 2003 mail system (especially off campus/business addresses)?  
There is a feature called Contacts to take care of this.  A contact is just what it indicates.  
You create your own contacts (like a personal address book).   

Adding Names to Contacts 

There are many ways to add names to Contacts.   

Adding names as you type the 
email addresses in 
the To or Cc areas 
of the message 
If a person’s email address 
is not currently in your Global 
Address List or Contacts, you 
can add it while you are in the 
process of sending them a 
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message.  In the area to the right of To or Cc, type in the email address for the person or 
persons you wish to receive your email.  If you type in several addresses, separate them 
with a semi-colon ( ; ).  Click away (somewhere else on the screen) from the address you 
typed. You will notice that, in a few moments, the addresses will become underlined.   

 

To add an address to your Contacts, simply 
right-click on a name that you typed, and a 
menu box will appear. 

 

Click on Add to Outlook Contacts and the 
Contacts entry menu screen will appear.   

 

 

 

The Contact entry menu screen appears below. 
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Normally, the first part of the email address you entered before the “@” symbol will 
appear in the full name box.  To change this to a logical full name click on the Full 
Name… button.   

When the Check Full Name 
box appears you can then fill 
in the entire name by filling 
in the appropriate areas 
(First:, Middle:, Last:, etc.) 

When you are finished, click 
on OK. 

 

 

 

You can now fill in the applicable areas for the person’s 
mailing address, if you want.  To do this, click on the address 
down triangle.  Click on Business, Home or Other. 

 

Your address area will 
change to your selection 
(we chose Home…).  After 
you make your selection 
(Business, Home, Other), 
type the address in the 
small box to the right of 
your selection.   

When you have completed everything, you can 
click on the Save and Close button. 

You will not return to your message.  To add 
additional names to your contacts address book 
repeat the above process again. 

When you are in the contact screen, you will notice that there are a lot of other tabs and 
areas which may also use to enter information about a person (General, Details, 
Activities, Certificates and All Fields). 
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Adding Names to Your Contacts as You Receive Email in Your Inbox 
Right-click on an email address also works when you receive a message from someone!  
If you know that an address is not in your Contacts, right-click on the address and add it 

as you did above.  This 
really saves a lot of time.  
You know it’s a good 
address, because you 
received their message! 

To the left is an image of 
the address area of an 
email in the Inbox.  We 
simply right-clicked on 
the person and then 
moved down the pop-up 
menu to Add to Outlook 
Contacts…, just like we 
did when we typed in the 
address in our new mail 
To area. 

Once you have clicked on 
Add to Contacts… you 
will go back to the same 
process that is outlined 
above. 
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Attachments 

Sending a Word document, Excel spreadsheet, PowerPoint presentation, picture, or file of 
some type to someone indicate that you sent them as “attachments” to your email. 

When you are sending an email message and want to include an attachment, it’s 
relatively easy.  When you are in the Untitled-
Message, the Forward or Reply screens, you 
will notice a “paperclip” in the button bar.   

This paperclip is the button that allows you to 
insert an attachment in your 
email message.  When you are 
ready to add an attachment, click 
on the paperclip.  The following 
Insert File menu screen will 
appear. 

When this Insert File screen appears, choose the location of your file (attachment) on 
your computer by using the Look in:  area (see the arrow above – we have chosen My 
Documents).  Then choose the file by clicking on it (we chose a PowerPoint file called 
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“How to make a great 2003 PBJ” for our 
attachment).  Click on OK.  Your email 
message, with attachment, will look 
similar to the image on the right.   

When you or, another person, receives this 
attachment, all you have to do is double-
click on the attachment and it will load 
into the proper program!  Or, you can right-
click the mouse on the attachment, and 
select Save as… then save it in the location 
you want.   
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Calendar 

There is a personal calendar you can use that is included 
with Outlook 2003.  You can access the 
Calendar by clicking on the Calendar icon in 
Outlook Shortcuts area on the left of your Outlook screen.  
A Calendar screen, similar to the one below, will appear. 
 

Notice, at the top of the calendar, a small area that looks like the image below.  The 
default for Outlook 2003 is a single day.  You can change this to view a 5 day work 
week, a 7 day week, or a full month.  We’ll now view each choice. 
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When you click the 5 Work Week button, an image similar to the one below will appear. 
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When you click 7 Week, this image will appear. 
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When you click 31 Month, this image will appear. 

 

You choose the view that you prefer.  For this tutorial we’ll use the 5 Work Week 
calendar. 

Making an Appointment 

There are several different methods of creating an 
Appointment in Outlook Calendar 2003.   

Probably the quickest way to create an appointment is to 
go to the calendar day for the appointment, and double 
click quickly on the space for the time and day for the 
appointment. 
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We want to make an 8:00 to 9:00 AM appointment on 
Monday, 30 August.  So, we double click 
quickly on 8:00 AM. We could also 
right-click on this time and date, and click New 
Appointment. 

Both of the above methods will open an Untitled – Appointment menu screen like the one 
below. 
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We’ll now enlarge the top portion of the Untitled – Appointment Menu Screen. 

 

Notice that the date and time we chose are indicated in the Start time area of the screen.  
We’ll now enter additional information on our meeting in the appropriate areas of this 
screen. 

 

In the image above, we entered the information on the person with whom we are meeting 
in the Subject area and then the place where we are meeting in the Location area.  Once 
you enter this information, you’ll see the “name” of the appointment change to the data 
you have entered in the Subject area.  We then clicked the down arrow to the right of 
End time and moved the time to 9:00 AM. 

Notice, below the End time, there is a check mark in the box to the left of Reminder.  
When this is checked, Outlook will pop up a box with a sound to remind you about an 
upcoming appointment.  To the right of Reminder it indicates 15 minutes – this is how 
many minuets before the meeting the reminder will occur.  To the right of 15 minutes is 
a down arrow.  If you click this down arrow, you can change the time to any time you 
prefer to be reminded of your coming meeting. 
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To the right of Location you’ll 
see an area called Label.  If you 
click the down arrow to the right of Label, 
a drop down menu will appear with different 
meeting labels and colors.  You can choose a 
meeting label and color if you want.  We 
chose “red” and “Important” for our meeting. 

Below the Reminder area you will see a 
blank white area.  This area is a “text box” 
where you can type additional information 
on your appointment if you need to do so.   

 

Your final appointment screen should look something like the one below.  When you 
have everything the way you want it, click the Save and Close button on the left of the 
screen. 

 

You will now return to your Calendar.  Depending 
on which “day view” you chose, you should see 
something like the image on the right – we are in 5 
Work Week. 
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If you need to change something on your Calendar it is fairly simple.  Simply click the 
left mouse button twice quickly on the appointment, and it will open the appointment 
screen for you to make any changes you want. 

Recurring Appointments 

Many times you will have a recurring meeting or appointment that repeats throughout the 
year, or for several months.  Outlook Mail Calendar 2003 has a feature that will allow 
you to schedule recurring meetings and appointments. 

Again, there are several ways to access this feature.  You can double click quickly on the 
first recurring meeting time and date and the 
appointment screen will appear.  Or, you can 
click on the Actions tab in the menu bar and 
then select either New Recurring 
Appointment or New Recurring Meeting 
(they both do the same thing). 

If you double click, you will have to click on 
the Recurrence button in the appointment 
screen. 

The recurring meeting/appointment is 
accomplished in two steps.  First, you have to 
enter what dates, days, hours, weeks that you 
will meet, and then enter the normal appointment data about the meeting.  We’ll start 
with the appointment recurrence menu screen and then 
finish with the normal appointment menu screen.  Once 
you click as indicated above both the appointment 
recurrence and Untitled - Appointment screens will 
appear as shown in the image at the top of the next page. 
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For this tutorial, we’ll use the example of a meeting that will be held twice a week for the 
next several months.  Our meeting will be from 10:00 to 11:00 AM, Tuesdays and 
Thursdays from 31 August 2004 through 18 November 2004.  First, we’ll complete the 
Appointment Recurrence menu screen.  Our screen, when finished, looks like the image 
below. 
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To complete your Appointment Recurrence screen, click the down arrows to the right of 
Start and End and select your meeting times, then select the Recurrence pattern 
(Daily, Weekly, Monthly, Yearly).  Select the days on which you will meet by clicking 
in the small check boxes to the left of the days (Sunday, Monday, etc.).   

In the lower portion of the screen, in the Range of 
recurrence area, click the down arrow to the right of 
Start and choose the specific day.  Simply click the 
day you want and it will appear in the Start area. 

If you need to move to another month, the right and left 
pointing triangles on either side of the month will 
move you ahead or back one month. 

Repeat this process in the End by area of the screen. 

When you have entered all of your data, click the OK 
button.  This will take you to the Untitled – 
Appointment menu screen.  Fill in your information as 
you did before, and then click Save and Close. 

Our screen looks like the one below. 

 

After we clicked Save and Close, we changed our calendar view to 31 Month, and 
moved to the month of September 2004.  You can now easily see, in the image at the top 
of the next page, that each of the meetings is schedule for the entire month.  If you moved 
to November, you would see the last meeting occurring on the 18th as entered. 
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Creating Appointments/Meetings and Inviting Others 

Another feature of Outlook’s Calendar is 
the ability to invite others to a meeting you 
are scheduling (if they also use Outlook’s 
Calendar) by clicking Actions in the menu 
bar and then click Plan a Meeting…. 

The Untitled – Meeting menu screen will 
appear (similar to the one below).  We have 
already selected several staff members to 
determine if the day and time we propose is 
available for them to meet – we’ll show you 
how we did this.  You can see from the 
image below that we have selected several people for a proposed meeting from 11:00 AM 
to 12:00 noon on Monday, 16 August 2004.  The blue lines you see below indicate the 
times that these staff members are currently busy and could not attend a meeting.  We 
used an AutoPick Next button to select the time you see below between the green (Start) 
and red (End) lines for our meeting.  Now we’ll show you how we did this. 
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In the Untitled - Meeting menu screen we clicked the 
Add Others button (see arrow above).  Then we 
clicked the Add from Address Book… selection.   

 

When we clicked the Add from Address Book button, the Select Attendees and 
Resources menu screen at the top of the next page appeared. 
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In the Type Name or Select 
from List  area we typed the 
name of a person we are 
inviting to the meeting. 

We then clicked on the Name of 
that person. 

Next we selected Required (as 
this person is essential to our 
meeting).  We could also have 
selected Optional. 

We repeated this selection 
process for the remainder of the 
staff we wanted to invite. 

When we completed our list we 
clicked the OK button. 

When we clicked the OK button 
we were returned to the Untitled 
– Meeting menu screen in the 
middle of the last page.  If you look back at the last page, you will see our four names and 
blue lines to the right of each name.  At the bottom of the Untitled – Meeting screen you 
will see that the color blue indicates the person is busy on some other appointment or 
task.   

Outlook Calendar 2003 has a nifty button which will 
assist you in finding “open” times for your group 
during which you can arrange a meeting.  At the 
bottom of the Untitled – Meeting menu screen is 
the AutoPick Next >> button.  We clicked this button 
and the green and red “band” appeared on our calendar and found the first “open” time.   

If you agree with this selection, you are 
ready to complete the scheduling by 
returning to the Appointment portion of 
the Untitled – Meeting menu screen.  If 
you are not satisfied with this selection, 
continue to click the AutoPick button. 
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You will notice the AutoPick begins by assuming you want a half hour meeting.  You can 
change this in two different ways.  You can place your cursor on the green or red lines 
(that outline the meeting), hold down the left mouse button and “drag” the line to expand 
the time.  From then on, Outlook Calendar 2003 will assume you want the longer meeting 
time selected.   

Or, at the bottom of the Untitled –
Message screen you can use the 
Meeting start and end time areas 
to select a length for your meeting. 

When you have everything just as 
you want, click the Appointment 
tab at the top of the Untitled – 
Meeting screen.  This will take 
you to the Untitled – Meeting 
menu screen where you will describe the meeting. When you have completed this screen, 
Outlook Mail, will send an email message to each of the participants asking if they want 
to attend the meeting.  The completed screen will look similar to the one below. 
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Once you have completed everything, 
click the Send button at the top of the 
Meeting menu screen. 

 

As soon as you click the Send button, each person you invited to the meeting will receive 
a message asking them to either Accept (attend the meeting), Decline (unable to make 
the meeting) or to accept Tentatively (maybe can make the meeting).   Their incoming 
message will look similar to the one below. 

 

 

If they accept your invitation, their Outlook will automatically post this meeting to the 
Calendar.  If they reject the meeting Outlook will not post the meeting.  If they accept 
tentatively, outlook calendar will post the meeting with tentative colors. You will receive 
an Outlook message indicating the response of each person invited to the meeting. 

Allowing Other Outlook Mail Users to View Your Cale ndar 

You can allow other Outlook Mail users to view your Outlook Calendar (regardless of the 
version of Outlook they are using).  Make sure you are in your Calendar. 

If you want to do this, 
click the File tab in the 
menu bar, then click 
Folder and then select 
Sharing. 

The Calendar Properties 
menu screen at the top of 
the next page will appear.   
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You should be on the 
Permissions tab in the Calendar 
Properties menu screen. 

To allow someone to view your 
calendar, click the Add button. 

 

 

 

 

 

 

 

 

The Add Users menu screen 
(which you have used several 
times before in this tutorial), will 
appear. 

Type in the name of the person 
you want to view your calendar in 
the Type Name or Select from 
List  area (top left arrow). 

Next, click on the name.  It will 
turn blue. 

Then click the Add button. 

Finally, click the OK button. 
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The Calendar Properties menu 
screen will appear (similar to 
the image on the right).   

You will see the name you 
entered highlighted in 
blue. 

Below the Name you will 
see a Permissions area.  It is in 
the Permissions area 
that you allow the person 
you entered to view as much, 
or as little of your calendar as 
you want.  You can see that 
you can give them very 
limited or complete access to 
your calendar.  You select the 
items that you want (by 
clicking in the squares and 
circles). 

Then click the OK button. 

The person to whom you gave 
permission to view your 
calendar may now access your 
calendar, in their Outlook mail 
account, by clicking File in 
their menu bar, then clicking 
Open and then selecting 
Other User’s Folder…. 

 

They will now see the Open Other User’s 
Folder menu screen.  They can either 
click the Name… button and select your 
name from the Select Name menu screen, 
or they can type your name in the area to 
the right of Name...   
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If they type in the person’s 
name, the Check Names menu 
screen will appear.  They 
should click the name they 
want (it will turn blue), and 
click OK .  

 

 

 

 

 

 

The person you allowed to view your 
Calendar will now see your calendar.  
Their screen should look similar to 
the one on the right. 
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Once the above process has been completed, the next time 
the person wants to see your calendar, they will see a 
screen with your calendar available (similar to the image 
on the right).  They can now place a check mark by your 
name, and your Calendar will appear.  To remove 
your calendar from view, they simply 
“uncheck” the box by your name. 
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Out of Office Assistant 

If you are going to be away from your email for a 
period of time, and you want to leave a courtesy 
message for folks to let them know that you’ll be away, 
you can use the Out of Office Assistant to do this.  To 
activate the Out of Office Assistant click on Tools in 
the menu bar and then click on Out of Office 
Assistant…. 

You will need to be in the Inbox, Sent Items, 
Deleted Items or one of your folder screens to do this. 

The Out of Office Assistant menu screen will appear. Type the message that you want 
others to receive when they send an email message to you.  Then click in the small circle 
to the left of I am currently out of the Office.  Click OK .  This message will be sent to 
each person the first time that they send you an email message telling them that you are 
away from the office.   

 

 

 

 

 

 

 

 

 

When you return (to your office), and 
load Outlook 2003, you will see a 
screen prompt reminding you that Out 
of Office Assistant is active.  You can 
“turn off” the Assistant when you see 
this message by clicking Yes. 
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Auto-Signature 

There is an Outlook 2003 feature, which allows you to 
place a “designed” signature at the end of your email 
messages.  You will need to be in one of the Main areas 
of Outlook 2003 to create a signature (Inbox, Sent 
Items, Deleted Items, etc.).   

To activate this feature, click on Tools in the menu bar.  
When the drop down menu appears, click on Options…. 

The Options menu screen will appear. When the above screen appears click on the Mail 
Format tab.   In the lower portion of the Options menu screen you will see and area 
called Signatures.  Click on the Signatures… button in this area. 
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The following Create Signature menu 
screen will appear. Click on the New button 
in this screen.  

 

 

 

 

 

The Create New Signature menu screen will 
appear. When the Create New Signature 
screen appears, type a “name” for your 
signature in the area under #1. Enter a name 
for your new signature (we used Greg 
Butler). 

We’ll leave “2. Choose how to create your 
signature” as the default choice – Start with 
a blank signature. 

Now click on the Next button.   

 

When the Edit Signature menu screen 
appears, type your signature in the space 
under Signature text – like we have 
done on the right.   

You can type anything you want for 
your signature.  You can type just your 
name, or name, title, phone, FAX, etc.  
It’s your signature. 

Notice that there are several buttons 
below the Signature text – Font, 
Paragraph, etc.  If you want to change 
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the font of your signature, highlight the text that you want to change, and then click on 
the Font button and select your font – then click OK in the Font menu screen.  You can 
have several different fonts in your signature if you want – as well as color. 

When you have the signature you want, click the Finish button.  This will take you back 
to the Create Signature menu screen.  Click OK .  The bottom portion of your Options 
menu screen should look similar to the image below. 

 

 

 

 

 

 

 

 

From now on, when you create a new message, reply to one, or forward one, you will see 
that you signature is automatically added at the end of the message.  If you want to edit 
your signature or create a new one follow the process above, and choose the logical 
buttons to Edit , Remove, or create a New signature. 

When you are satisfied with your signature, click OK. 
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Accessing Your Email through a Web Browser 

First, you’ll need to be in a browser such as Microsoft Internet Explorer.  You can be in 
Netscape Communicator, Mozilla, or some other browser, but we have noticed that 
ONLY  Microsoft Internet Explorer (version 5.1 or higher) allows you to see/use all of 
the features of Outlook Web Access 2003.  Mac users will notice that several of the 
features covered in this tutorial are not available to them.   

Logging In 

Once you are in the browser, you can access your email through the SON intranet 
(http://intranet.son.washington.edu). You will then see the following, and should log in 
with your UW ID and password.   

   

You can then click on the NURS-Kit button on the left, and then the Outlook button. 

 



Outlook  
User Guide 
 

 
Adapted with permission from materials from Lynchburg College, Last Updated 1/7/2008 48 of 50 

You will then see the following prompt to 
enter your user name and password.  

After you enter your information and press 
enter, you will see “Outlook Web Access,” 
which looks very similar to the normal 
Outlook.  You’ll notice, however, you are still 
in a web browser, with the address 
https://webmail.son.washington.edu/.  You 
can also enter this web address yourself if you 
wish to go directly to webmail without 
logging in to NURS-KIT. 

Customizing Views 

At the bottom of the navigation pane you will see buttons for 
Inbox, Calendar, etc.  When you click these buttons, you 
will be taken to that feature.  So, go ahead and click the 
buttons as you desire.  When you have explored a bit, click 
again on the Inbox button.  We’ll come back to several of 
the buttons later in the tutorial. 

At the very top of this area is a little down arrow with four 
dots on either side  

If you click on this bar, you will see your buttons disappear.  
This is the Enlarge Button Bar/Shrink Button Bar .  So, 
you can “hide” your buttons just like you did your folders.  
To see the buttons again, simply click on the bar again and 
the buttons will re-appear. 

Refreshing Your Window 

Since you are on a web browser, you’ll need to check and see if you have new messages 
that have arrived since you began your mail session.  You can click the Check Messages 
button at the bar on one of your folder screens (Inbox, etc). 
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Options  

If you are used to Out of Office Assistant, Signature, and many other features in Outlook, 
most of these are now located in the Options menu screen.  If you look at the top right 
side of your screen you will see the Options button.  Click it, and the features of the 
Options will appear in the button part of the navigation pane. 

 

 

 

 

We’ll now review several of the most popular topics in the Options menu.  Most are self 
explanatory, and you can peruse them if you desire.  Keep in mind the Help feature in 
Outlook Web Access is excellent, and will guide you through each option if you need 
further assistance. 

 

 

 

 

 

 

Out of Office Assistant 

If you are going to be away from your office computer for a period of time, and you want 
to leave a courtesy message for folks to let them know that you’ll be away, you can use 
the Out of Office Assistant to do this.  To activate the Out of Office Assistant, click on 
the Out of Office Assistant button.  Type the message that you want others to receive 
when they send you an email message.  Then click in the small circle to the left of Send 
out of Office auto-replies.  This message will be sent to each person the first time that 
they send you an e-mail message telling them that you are away from the office (see the 
image on the top of the next page).   

Save Your Options    

Anytime you change various options (such as the Out of Office Assistant) and are 
ready to go leave the Options page, you’ll need to click at the top of the Options area. 
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Auto-Signature 

Clicking Messaging button will allow you to place a “designed” signature at the end of 
your e-mail messages.  Click the box of automatically include my signature on outgoing 
message and click Save.  Your signature will show up in the end of the e-mails that you 
send out. 

 

Other Options  

In the navigation pane, some of the more popular features include: 

�  Regional Settings 
�  Junk E-mail 
�  Calendar 
�  Accessibility 
�  Mobile Devices 


